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Chapter 1: Getting Started

The following sections will help you get started using the FieldSpec®4 instrument:

 “1.1 About This Manual” on page 1

 “1.2 Technical Support” on page 2

 “1.3 FieldSpec 4 Instrument Overview” on page 2

 “1.4 Unpacking the Instrument” on page 4

 “1.5 Setting Up the Instrument” on page 5

 “1.6 Setting Up RS3 and Saving Spectra” on page 7

1.1 About This Manual 
This manual is for users of the FieldSpec 4 instrument and describes how to set up and use the 
instrument. It also includes reference information about how the instrument works.

This manual uses the following symbols and typographical conventions.

 

Cautions and notices throughout this manual are for the convenience of the reader. However, 
the absence of cautions and notices do not preclude the use of proper caution and handling. 
Take the normal precautions at all times, either written or otherwise, to avoid personal injury or 
equipment damage.

Convention Definition

Bold Words in bold show items to select or click, such as menu items or buttons. 

File > Open This notation shows software menu selections. (For example, from the File 
menu, select Open.) 

This symbol indicates practices not related to personal injury.

This symbol indicates a hazardous situation which, if not avoided, could 
result in minor or moderate injury.

Items with this symbol indicate that the item should be recycled and not 
disposed of as general waste.
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1.2 Technical Support
If you have any questions or concerns, please contact ASD Inc., a PANalytical company by 
phone, fax, or e-mail:

Phone: 303-444-6522 extension 3
Fax: 303-444-6825
e-mail: NIR.support@panalytical.com
Web: support.asdi.com

Technical support is available to answer your questions Monday through Friday, 8 a.m. to 5 p.m. 
Mountain Time. 

1.3 FieldSpec 4 Instrument Overview 
The FieldSpec 4 instrument is a general-purpose spectroradiometer that is useful for many 
applications requiring the measurement of reflectance, transmittance, radiance, or irradiance. A 
spectroradiometer is a special kind of spectrometer that can measure radiant energy (radiance 
and irradiance.) The FieldSpec 4 instrument has a fixed fiber optic cable that lets you calibrate it 
to units of radiant energy (irradiance and radiance).

The instrument is specifically designed for field environment remote sensing to acquire visible 
and near-infrared (VNIR) and short-wave infrared (SWIR) spectra. The instrument is a compact, 
field portable, and precision instrument with a spectral range of 350–2500 nm and a rapid data 
collection time of 0.2 second per spectrum. 

The FieldSpec 4 is available in the following models:

For the complete specifications, see “Appendix A, Specifications and Compliance” on page 46. 

To use the instrument, you must have a laptop computer (instrument controller) and the 
appropriate software. The instrument typically comes with both, but if you need to use your own 
computer, see “2.1 System Requirements” on page 9.

Table 1.1: FieldSpec 4 models and spectral resolutions

Spectral resolution

Model VINR (nm) SWIR (nm)

Wide-Res 3 30

Standard-Res 3 10

Hi-Res 3 8

Hi-Res NG 3 6
FieldSpec® 4 User Manual 2
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Figure 1.1 shows the front panel of the instrument.

Figure 1.1: FieldSpec 4 instrument front panel

Figure 1.2 shows the back panel of the instrument.

Figure 1.2: FieldSpec 4 instrument back panel

Accessory power port

Fiber optic cable (fixed)

Ethernet port to 
connect to the 
instrument 
controller

On/off switch

Power port Not usedService port (for 
ASD use only)

Wi-Fi/Ethernet 
button
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1.4 Unpacking the Instrument 
The instrument ships in a hard-shell carrying case, as shown in Figure 1.3. 

Figure 1.3: Instrument as it ships

The backpack and laptop carrier ship separately and are in the soft-sided case, as shown in 
Figure 1.4.

Figure 1.4: Backpack in soft-sided case

Instrument and 
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Battery (1; additional 
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Power cable, Ethernet 
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Contact probe 
(optional)

Computer

Backpack
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To unpack the instrument:

1. Inspect the shipping containers and note any damage. 

• Save all packing materials, foam spacers, and paperwork for future use.

2. Open the shipping containers, following all instructions and orientation labels.

3. Remove the instrument from its shipping case and place it on a sturdy bench or counter 
with an electrical outlet available. 

• If an electrical outlet is not available, you can use the battery instead. The battery 
was partially charged at the factory, and we recommend you fully charge it before 
use.

4. Remove the instrument controller (computer). 

5. Remove the cables for the instrument controller.

6. Remove the backpack (accessories inside) from the soft-sided case.

• Some accessories are optional.

1.5 Setting Up the Instrument 
You must connect the instrument, the instrument controller (computer), and accessory light 

source (if required). If you plan to use your own computer, see “System Requirements” on 
page 9.

To set up the instrument:

1. Connect the power cable to the back of the instrument (screw it into the port) and to an 
electrical outlet.

• For information about using the battery instead, see “Using the Battery” on page 11.

The instrument can have only one active network connection 
(Ethernet or wireless) at a time. The Wi-Fi/Ethernet button on the back 
of the instrument determines the active connection. When the button 
is green, the wireless connection is enabled.
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2. Connect the Ethernet cable to the instrument controller’s Ethernet port and to the back of 
the instrument.

• The location of the Ethernet port varies on different instrument controllers.

• If you want to use wireless communication between the instrument and instrument 
controller, do not connect the cable. For more information, see “2.4 Setting Up 
Ethernet or Wireless Communication” on page 12.

3. Press the Wi-Fi/Ethernet button to make the button black.

• The button toggles between black (button out) for Ethernet and green (button in) for 
wireless.

4. Connect the power cable to the instrument controller and to an electrical outlet.

5. If you are using a contact probe or Muglight, connect the accessory power connector to 
the accessory power source and insert the fiber optic cable into the accessory.

• For more information, see “Using Accessory Light Sources” on page 17.

6. If you are using the pistol grip or the remote trigger, connect them .

• For more information, see “Using the Remote Trigger” on page 17 and “Using the 
Pistol Grip” on page 16.

7. Turn on the instrument.

8. If using an optional accessory light source, turn it on.

9. Let the instrument warm up for at least 15 minutes.

• If you are collecting radiometric spectra, let the instrument warm up for at least one 
hour before collecting radiance or irradiance data.

10. Turn on the instrument controller.

• A Windows message indicating that the connection was unsuccessful may display. 
Click Close, and the wireless network should show Limited Access. Start the RS3 
software, and the status will change to Connected.

For information about using the instrument with the backpack and laptop carrier, see “Using the 
Laptop Carrier (Belly Board)” on page 20 and “Using the Backpack” on page 21.

Ethernet port to 
connect to the 
instrument controller

On/off switch

Power port

Wi-Fi/Ethernet 
button
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1.6 Setting Up RS3 and Saving Spectra 
After you start the RS3 software, you must optimize and set a white reference. You can then 

collect and save spectra.

To set up the software and save spectra:

1. Start the RS3 software.

• Double-click the RS3 icon  from the instrument controller’s desktop.

• If you are using one of the default network configurations, RS3 automatically detects 
and connects to the instrument. For more information, see “2.4 Setting Up Ethernet 
or Wireless Communication” on page 12.

2. Point the end of the fiber optic cable at the Spectralon® reference panel and hold it 
there.

3. Click Opt to optimize the instrument.

• The optimization is complete when the Spectrum Avg progress bar resumes.

4. Click WR to take a white reference.

• A white reference is only useful when collecting reflectance data. This step is not 
necessary when collecting radiance or irradiance data.

• The white reference is complete when the Spectrum Avg progress bar resumes.

White 
reference 
button

Optimize 
button

The software starts collecting spectra immediately. The 
Spectrum Avg progress bar shows the spectra collection.
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5. Point the end of the fiber optic cable at the sample and hold it there until the spectrum 
average collection is complete.

6. Select Control > Save Spectrum.

7. If you would like to change the file save location of your spectrum, browse to where you 
want to save the spectrum and enter a file name.

• For more information about the Spectrum Save window, refer to the RS3 User’s 
Guide.

8. Do one of the following:

• To save the settings in the Spectrum Save window but not save any spectra yet, click 
OK. Then use the instrument controller’s space bar or the remote trigger to save 
spectra.

• To begin saving spectra immediately, click Begin Save.

Use the ViewSpecTM Pro software to view and post-process the saved spectra. For more 
information about using the RS3 or ViewSpec Pro software, refer to the RS3 User’s Guide or the 
ViewSpec Pro User’s Guide.
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Chapter 2: Using and Maintaining the 
Instrument

The following sections will help you use and maintain your instrument:

 “2.1 System Requirements” on page 9

 “2.2 Ventilation Requirements” on page 10

 “2.3 Power Options” on page 10

 “2.4 Setting Up Ethernet or Wireless Communication” on page 12

 “2.5 Understanding the Fiber Optic Cable” on page 13

 “2.6 Options for Collecting Spectra” on page 15

 “2.7 Shipping and Carrying the Instrument” on page 19

 “2.8 Setting Up GPS” on page 30

 “2.9 Maintaining the Instrument” on page 36

2.1 System Requirements
To use the instrument, you must have a laptop computer (instrument controller) and the 
appropriate software. If you did not purchase an instrument controller from ASD or need to use 
your own computer, the following sections provide the system requirements:

 “Computer Requirements” on page 9

 “Software Requirements” on page 10

Computer Requirements
The instrument controller is a computer that manages the instrument, stores data, and processes 
the results.

The minimum requirements for the instrument controller are: 

 1.0 GHz or higher CPU 

 512 MB or higher RAM 

 600 MB or higher of free disk space 

 Microsoft® Windows® XP or Windows 7
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 800 x 600 or higher graphics resolution 24-bit color or better, 32-bit recommended 

 10/100 Base-T Ethernet interface

 Ethernet wireless (Wi-Fi) adapter: PCMIA, USB, or internal that is compatible with the 
802.11g standard

 (Optional) Serial communications port (RS-232 COM, Bluetooth®, or USB; only needed 
if a GPS is used). Contact ASD for information about using GPS receivers with ASD 
instruments.

Software Requirements 
The instrument controller requires the following software:

 Microsoft Internet Explorer 6.0 or higher

 RS3 spectral acquisition software from ASD

You should have a basic understanding of the Microsoft Windows operating system, including 
software installation. 

International customers using non-English versions of Windows must change the Regional 
Settings under Start > Settings > Control Panel. The default language must be set to English 
(United States) for the software to be registered and operate correctly. The numbering format 
must also be set to English. 

2.2 Ventilation Requirements
When used inside, provide adequate room ventilation for the instrument. Insufficient ventilation 
can result in overheating of the instrument, corrupted data, and possible physical damage to the 
instrument. 

Follow these additional tips about using the instrument:

 Do not cover the vents of the instrument. Be sure the vents line up with the mesh in the 
backpack to ensure adequate ventilation and make sure the mesh and vents are not 
obstructed.

 Prevent objects from obstructing ventilation holes.

 Keep objects and spills from entering or falling onto the instrument and power supplies. 

2.3 Power Options
The instrument requires input power of 12 VDC (60 W). It does not contain an internal power 
supply or battery.

The three options for providing the instrument with the appropriate DC voltage are:

 A power cable that connects to an electrical outlet (included).

 An external battery (included). For more information, see “Using the Battery” on 
page 11.
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 A power cable for a 12 V DC vehicle outlet (included; should not be used with vehicle 
engine running).

Using the Battery
When electrical power is not available, use the battery that came with the instrument. The 
Nickel-Metal Hydride (NiMH) battery can power the instrument and accessories. 

A fully charged battery’s life depends on the battery age, instrument configuration, environment, 
and accessories powered by the accessory power port. The expected battery life is over four 
hours using a contact probe in an ambient environment.

For the complete battery specifications, see “A.3 Battery Specifications” on page 47.

The battery charger is designed for indoor use and should not come in contact with water or 
dust.

For the complete battery charger specifications, see “A.4 Battery Charger Specifications” on 
page 47. Refer to the charger instruction manual for usage details.

The backpack has two pouches on the hip belt, either of which can hold the battery. However, 
the battery should be on the opposite side from the fiber optic cable.

Charging the Battery 
Charge a new NiMH battery fully before using it the first time, even if it shows full voltage and 
power. The battery pack reaches its peak performance after three to five charge-and-discharge 
cycles. A fully discharged battery takes about eight hours to charge.

Use only ASD-approved power supplies or connectors to 
power the instrument.

Use only batteries supplied by ASD. Use ASD batteries only as 
authorized by ASD. Using improper batteries or improper use 
of ASD batteries could result in bodily injury or damage to the 
instrument.

The instrument will stop collecting spectra when the battery 
drains to about 10 Volts, and the software displays a message 
that says it is unable to collect. However, the instrument and 
any attached accessory will continue to draw current if power 
is left on. Turn off the instrument and remove all accessories 
as soon as possible when the above message displays.

Do not unplug the charger and leave the battery in the charger. 
Remove the battery first, or the battery will discharge through 
the charger.
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After five to ten days from fully charging, the battery starts to lose its charge at the following 
rates:

 At normal room temperature—Loss of about 1% per day.

 At higher temperatures—Loss increases.

 At lower temperatures (40-60°F)—Loss decreases.

The more you use and charge NiMH batteries, the longer they last. Whether discharged or not, 
you should charge the NiMH battery at least every 60 days. New NiMH batteries can last from 
500 to 1000 charges.

The LED Status indicator on the battery charger has the following states:

 Orange—Indicates one of the following:

• The battery is not connected.

• The charger is initializing and analyzing.

 Red—Indicates a fast charge.

 Green with intermittent orange—Indicates a top-off charge.

 Green—Indicates a trickle charge.

 Alternating orange/green—Indicates an error.

Power Status Icon
The software from ASD has a Power Status icon at the bottom of the main window next to the 
Connection Status. When you hold the mouse pointer over the icon, a pop-up window shows 
the voltage level of the instrument.

 11-12 Volts is considered good (full).

 <11 Volts issues a warning.

Figure 2.5: Example Power Status

2.4 Setting Up Ethernet or Wireless 
Communication

The instrument communicates with the instrument controller to collect spectra using standard 
protocols for computer networks. 

By default, the instrument and instrument controller (if purchased from ASD) are set up to work 
in the following configurations:

 Ethernet connection—Connect the instrument to the instrument controller with the 
Ethernet cross-over cable provided with the instrument.
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• The ASD software automatically finds and connects to the instrument using the 
instrument’s default IP address (10.1.1.11). Make sure the Wi-Fi/Ethernet button on 
the instrument is black (button out).

 Wireless connection—The instrument and instrument controller communicate directly 
with each other using wireless communication.

• This method does not require the availability of a wireless network in your location. 
The instrument and instrument controller communicate directly, similar to the 
Ethernet connection method, only without a cable.

• The ASD software automatically finds and connects to the instrument using the 
instrument’s default IP address (10.1.1.11). Make sure the Wi-Fi/Ethernet button on 
the instrument is green (button in).

If you did not purchase the instrument controller from ASD or have configured the instrument 
controller to connect to a network, you must change the instrument controller’s network settings 
to connect to the instrument. See “Changing the Network Settings on the Instrument Controller” 
on page 39.

2.5 Understanding the Fiber Optic Cable
ASD offers a variety of fiber optic cable lengths to use with the instrument. A single cable, 
without any interruption in the fiber optic connections, allows for accurate measurement of 
radiance and irradiance in absolute units, and ensures the highest level of signal throughput.

The fiber optic cable is made up of fifty-seven (57) randomly distributed glass fibers:

 Nineteen 100-micron fibers for the VNIR region.

 Nineteen 200-micron fibers for the SWIR 1 region.

 Nineteen 200-micron fibers for the SWIR 2 region.

Each broken fiber results in a response loss of approximately 5% in the associated region.

Handling the Fiber Optic Cable
The fibers of the fiber optic cable are well protected inside the cable, but the fibers can be 
damaged through rough usage. You should periodically inspect the fibers for breakage by 
following the procedures in “Checking the Fiber Optic Cable for Broken Fibers” on page 14. 

The instrument can have only one active network connection 
(Ethernet or wireless) at a time. The Wi-Fi/Ethernet button on the 
back of the instrument determines the active connection. When the 
button is green, the wireless connection is enabled.

The fiber optic cable should never be stored with a bend of less 
than a 5" diameter for long periods of time.
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If left in a tight coil for longer than a week, the fibers may develop longitudinal fractures that will 
not be detectable. These fractures in the fiber will cause light leakage, resulting in a weaker 
signal. 

Store the fiber optic cable in the netting compartment on the instrument or on the fiber optic 
spool.

Follow these tips for handling the fiber optic cable:

 Do not pull or hang the instrument by the fiber optic cable. 

 Avoid whipping the fiber optic cable, dropping it, or slamming it into objects, as this can 
cause fractures to the glass fibers. 

 Avoid twisting the fiber optic cable, such forces may cause fractures to the fibers.

While the tip of the fiber optic cable is not particularly susceptible to damage, we recommend 
using the tip cover to protect against abrasion and exposure to contamination. You can make a 
replacement cover using eighth-inch shrink tubing cut 1.5" and shrinking it onto the fiber cable 
tip. The tubing will slide on and off the cable easily. 

Checking the Fiber Optic Cable for Broken Fibers
In the rare instance that a fiber is broken, you will see a loss in response. Fiber Check is a utility 
that lets you inspect the fiber optic cable for broken fibers. 

You can use the instrument with a few broken fibers in each region, but the signal strength is 
reduced. You should replace the fiber optic cable if the number of broken fibers causes the 
signal-to-noise ratio to drop below an acceptable level. 

To check the fiber optic cable for broken fibers:

1. Remove any fore optic accessories from the instrument’s fiber optic cable.

2. Attach the fiber inspection scope/magnifier to the end of the fiber optic cable.

The Fiber Check utility produces rapid flashing lights in the 
SWIR 1 and 2 regions’ optical fibers. If you are susceptible to 
epileptic seizures, exercise caution or avoid using the Fiber 
Check utility.

Fiber inspection 
scope/magnifier
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3.  On the instrument controller, exit any ASD software that might be running and 
communicating with the unit. 

4. Ensure that the instrument is turned on.

5. Start the Fiber Check software from the Start menu under All Programs > ASD Programs 
> RS3 Tools > Fiber Check.

6. Verify the IP address for the instrument.

• If you are directly connected to the instrument with a cross-over Ethernet cable or a 
wireless connection, the default IP address is 10.1.1.11.

7. Select the LEDs to turn on: VNIR, SWIR 1, or SWIR 2. 

8. Click Check to turn on the selected LEDs.

9. Look through the magnifier to see which fibers illuminate. 

• Count the number of fibers that light. Refer to “Understanding the Fiber Optic 
Cable” on page 13.

• If applicable, change the LED options and click Check to turn on and off different 
LEDs to help determine which range might be affected. It is best to check only one 
region at a time.

• The white LED for VNIR may be hard to see when the other ranges are enabled.

10. When you are finished, shut down the Fiber Check software.

11. Carefully remove the magnifier.

2.6 Options for Collecting Spectra
You can use various accessories to aid in collecting spectra, depending on your needs. Some 
accessories come standard with the instrument, and some require a separate purchase. You can 
use the remote trigger with any of the collection methods. For information about the remote 
trigger, see “Using the Remote Trigger” on page 17.

You can collect spectra the following ways:

 Without any attachment—Use the fiber optic cable on its own, without any accessory 
attached to it, using ambient light.
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 Pistol grip—Provides a convenient way to hold and aim the fiber optic cable to collect 
spectra using ambient light. For more information, see “Using the Pistol Grip” on 
page 16.

 Accessory light sources—Provide artificial light for sample illumination. For more 
information, see “Using Accessory Light Sources” on page 17.

 Fore optics—Narrow the field of view for collecting spectra. For more information, see 
“Using Fore Optics” on page 17.

 Remote trigger—Provides a way to start spectra collection without using the keyboard 
on the instrument controller. For more information, see “Using the Remote Trigger” on 
page 17.

Using the Pistol Grip
The pistol grip is a convenient way to hold and aim the fiber optic cable. The pistol grip comes 
standard with the instrument and does not affect the fiber optic cable’s 25° field of view.

To use the pistol grip:

1. Insert the fiber optic cable through the strain relief spring

2. Insert the fiber optic cable all the way through the pistol grip until it clicks.

• Make sure that the fiber optic cable tip is fully seated into the nose of the pistol grip.

3. If needed, gently tighten the set screw on the top of the pistol grip with a 1/8” flat blade 
screwdriver. 

• Tighten the set screw just enough to hold the fiber optic cable in place.

Do not pull hard on the cable after tightening the set screw. 
Pulling hard on the cable could potentially break the cable 
fibers. Loosen the set screw to remove the fiber optic cable 
from the pistol grip.

Do not adjust the factory set screw.

Strain relief spring

Fiber optic cable

Set screw

Factory 
set screw
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Using Accessory Light Sources 
If needed for your application, you can use an accessory light source, such as the contact probe 
or other ASD-approved accessory, with your instrument.

Use the accessory power port on the front of the instrument to connect accessories to power. 

Figure 2.6: Accessory power port

Contact ASD or refer to the manual for the accessory for more information.

Using Fore Optics
ASD offers a wide selection of fore optic accessories to meet a variety of application needs, 
including:

 Lenses that decrease the field of view from the fiber optic’s 25° field of view to as little as 
1°

 Radiometric calibration for radiance (W/m2/sr/nm) measurements

 Diffuse transmission and reflective-type cosine receptors and radiometric calibrations 
for measuring full sky irradiance (W/m2/nm)

For more information about field of view, see “Understanding the Field of View” on page 17. For 
more information about fore optic accessories, contact ASD.

Understanding the Field of View
The field of view determines the size of the data collection area. Using just the bare fiber optic 
cable or the pistol grip accessory, the field of view is 25°. 

As a general rule when using the bare fiber, the diameter of the field of view is equal to half the 
distance the fiber optic cable is from the sample. For example, if the cable is four feet from the 
sample, the field of view is about two feet wide.

When collecting data, be sure that the sample or reference panel is the only object within the 
field of view. 

Using the Remote Trigger
A remote trigger comes with the instrument to let you save spectra without pressing the space 
bar on the instrument controller (the normal method of saving spectra). This is convenient when 

Accessory 
power port
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you have both hands holding the sample and the fiber optic cable. You can attach the remote 
trigger to the pistol grip and save spectra by pressing the button on the trigger. 

To use the remote trigger:

1. Attach the remote trigger cable to the instrument.

2. Use the hook and loop fasteners that come with the remote trigger to attach it to the 
pistol grip.

• Place a piece of hook fastener on the back side of the remote trigger button.

• Place a piece of loop fastener on each side of the accessories, such as the pistol grip, 
so you can use the trigger with either hand, if necessary.

3. When collecting spectra, press the trigger button to collect spectra, instead of pressing 
the space bar on the instrument controller.

Remote trigger

Remote trigger 
connector

Remote trigger 
on the pistol 
grip
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• The LEDs on the trigger are bright enough to be seen even on a sunny day. The LEDs 
light when the trigger is pushed (briefly) and turn off when the capture is complete.

2.7 Shipping and Carrying the Instrument 
The following sections describe how to ship and carry the instrument:

 “Shipping the Instrument” on page 19

 “Carrying the Instrument in the Field” on page 19

 “Using the Laptop Carrier (Belly Board)” on page 20

 “Setting Up the Laptop Carrier for First Use” on page 20

 “Using the Backpack” on page 21

 “Adjusting the Backpack Straps to Fit” on page 25

 “Carrying Accessories and Supplies” on page 29

 “Protecting the Instrument from Bad Weather” on page 29

Shipping the Instrument

The instrument ships in a hard-shell container that you should use whenever you ship the 

instrument to different locations. Pack the instrument and its accessories as shown in Figure 1.3 
on page 4. Store the fiber optic cable in the netting on top of the instrument, not in the fiber 
optic spool. 

Use the soft-sided case only for nonbreakable items such as the backpack and laptop carrier.

Carrying the Instrument in the Field
The instrument comes with a laptop carrier and backpack that let you carry all of the equipment 
you need to collect spectra in the field. 

To use the instrument in this way, you must complete the following tasks:

1. Set up the laptop carrier.

• You only need to do this the first time you use the laptop carrier. See “Using the 
Laptop Carrier (Belly Board)” on page 20.

2. Set up the instrument in the backpack.

• See “Using the Backpack” on page 21.

3. Adjust the backpack straps.

• See “Adjusting the Backpack Straps to Fit” on page 25.

4. (Optional) Attach the pistol grip clip.

• See “Attaching the Pistol Grip Clip” on page 26.

For additional information about using the backpack in the field, see:

 “Carrying Accessories and Supplies” on page 29
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 “Protecting the Instrument from Bad Weather” on page 29

Using the Laptop Carrier (Belly Board)
The laptop carrier or belly board lets you carry the instrument controller in the field as you 
collect spectra. You can use it the following ways:

 With the neck strap—The laptop carrier can hold the instrument controller without the 
backpack when two people are operating the equipment.

 Without the neck strap—You can attach the laptop carrier directly to the shoulder straps 
of the backpack to let one person operate the instrument.

Setting Up the Laptop Carrier for First Use
Before using the laptop carrier for the first time, you must place matching hook and loop strips 
on the instrument controller (bottom) and laptop carrier (top).

To attach the hook and loop strips to the instrument controller and laptop carrier:

1. Remove the instrument and instrument controller from the backpack.

2. Put on the empty backpack and fasten the belt and adjust the shoulder straps for 
comfort.

3. Detach the laptop carrier from the neck strap and attach it to the shoulder straps of the 
backpack.

4. Adjust the straps of the laptop carrier for comfort and location.

Hold the instrument controller securely at all times.

Strap to attach 
laptop carrier to 
backpack

Laptop carrier
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5. Place the instrument controller on the laptop carrier temporarily and observe its 
location.

• Determine where on the laptop carrier to place the instrument controller and allow 
for comfortable use of the keyboard. 

6. Remember this placement and place the instrument controller on a table.

7. Detach the laptop carrier from the backpack.

8. Locate the two pairs of hook and loop strips (mating hook side and loop side) supplied 
with the laptop carrier.

9. Leave the hook and loop strips mated.

10. Remove the backing from the adhesive on the hook side of one strip and press it in 
place, adhesive side down, onto the laptop carrier an inch or so away from the straight 
edge.

11. Repeat step 10 with the other hook and loop strip, but place it a couple of inches or so 
away from the other strip. 

12. With the hook and loop strips still mated, remove the backing from the adhesive side of 
one strip.

13. Remembering the placement of the instrument controller on the laptop carrier, place the 
instrument controller onto the exposed adhesive and press down firmly. 

14. Gently separate the hook and loop material of the instrument controller from that of the 
laptop carrier. 

15. Smooth over the strips on both the instrument controller and laptop carrier.

16. Repeat steps 12 through 15 for the other strip.

Using the Backpack
When arriving on site, unpack the instrument from the shipping case, and set up the instrument 
in the backpack before use.

Make sure the hook and loop strip will not cover the battery 
compartment on the instrument controller. This will interfere 
with battery replacement.
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You can use the instrument in the backpack with either hand. Determine which hand you want 
to use for collecting spectra with the fiber optic cable and which you need available to type on 
the keyboard and handle samples.

Aiming the fiber optic cable or accessory will probably require less dexterity than operating the 
instrument controller and typing. You may want to set up the instrument with the fiber optic 
cable on the side of your nondominant hand and keep your dominant hand free for other tasks, 
like one-handed typing. 

To set up the instrument in the backpack:

1. Follow the instructions for unpacking the instrument from the shipping case.

• See “1.4 Unpacking the Instrument” on page 4.

2. Place the backpack on a flat surface with the shoulder straps down.

3. Determine which hand you want to use for the fiber optic cable. 

4. Orient the instrument in the backpack with the fiber optic cable on that side.

• The only requirement for orienting the instrument is that the plastic end-caps must 
be at the top and bottom of the backpack.

5. Close the five strap connectors to secure the instrument in the backpack.

6. If you are using the fiber optic spool, feed the fiber optic cable into the spool.

7. If you are using the fiber optic spool, attach it to the backpack one of the following ways:

Fiber optic cable on left 
side

Two of the five straps to 
secure the instrument
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• With the hook and loop material to the back of the backpack. If needed you can run 
the fiber optic cable through the loop on one of the battery pouches. The hip belt of 
the backpack has a battery pouch on each side.

• With snaps to a battery pouch. Use the pouch on the opposite side from where the 
battery is.

Fiber optic spool (attached 
to back of backpack with 
hook and loop material)

Fiber optic spool snaps onto the battery 
pouch on the belt of the backpack.

Fiber optic spool

Battery pouch
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• If the fiber optic cable is short, it can go directly from the instrument through the 
loop on the battery pouch.

8. Place the battery into the pouch on the opposite side of the backpack from where the 
fiber optic cable is. 

9. Feed the battery cable from the battery pouch under the cross strap to the power port of 
the instrument.

Fiber optic cable

Loop on battery pouch

Battery cable
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10. Attach the laptop carrier to the plastic connectors on the shoulder straps of the 
backpack.

11. Place the instrument controller onto the laptop carrier, matching the strips of hook and 
loop material.

• The laptop carrier is equipped with a pistol grip holder.

Adjusting the Backpack Straps to Fit
For better weight distribution and comfort, adjust the shoulder straps and yoke to your height 
while wearing the fully loaded backpack.

The torso adjustment system is controlled by gravity. You must 
have the backpack on your back and fully loaded for the 
adjustments to work properly.
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To shorten the torso adjustment:

 Pull the strap on left of backpack (as shown) until the yoke and shoulder straps raise up 
to the desired position, and the weight is comfortably distributed.

To lengthen torso adjustment:

 Push up on the plastic speed grip clamp on the left of the backpack to release the strap, 
lower pack, and lengthen straps, as shown.

Attaching the Pistol Grip Clip
If you want to attach the pistol grip to the backpack, you must assemble and attach the pistol 
grip clip. The clip lets you securely attach the pistol grip to the backpack strap. 
FieldSpec® 4 User Manual 26



  
The pistol grip clip has two components that you must assemble before use: 

 Pistol grip link that screws onto the pistol grip.

Figure 2.7: Pistol grip link

 Pistol grip latch housing that clamps onto the backpack.

Figure 2.8: Pistol grip housing

Required tools:

 Phillips screwdriver

To prepare the pistol grip:

1. Determine which hand you want to use for the pistol grip.

2. Remove the screws from the pistol grip link and separate the plate and the link.

PlateLink Screws

Bottom part Top part
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3. Attach the pistol grip link to the pistol grip based on the hand you want to use, as 
shown.

• Make sure the plate is seated flat against the side of the pistol grip.

4. Locate the waist strap on the side where you want the pistol grip.

5. Loosen the four screws on the pistol grip clip housing and remove the bottom part.

6. Place the bottom part of the pistol grip clip housing under the strap and the top part on 
top of the strap.

• Make sure the top part of the housing will be on the outside when you put on the 
backpack.

7. Tighten all four screws, but leave them loose enough to slide the housing on the strap.

8. Put on the backpack and slide the housing where you want it.

9. Tighten all four screws.

Placement for right 
hand use

Placement for left 
hand use

Two screws (not 
shown)

Link

Plate

Two screws Link

Plate (not 
shown)

Bottom part of 
pistol grip clip 
housing

Top part of pistol 
grip clip housing

Latch release
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10. Slide the pistol grip link into the housing until it clicks to keep the pistol grip securely 
attached. 

• To remove the pistol grip, use the latch release and pull the pistol grip up.

Carrying Accessories and Supplies
The backpack is designed specifically for the instrument. The large mesh pocket at the bottom of 
the pack provides ventilation to keep the instrument from overheating.

Protecting the Instrument from Bad Weather
The backpack has a small interior pocket near its top that holds a rain flap, as shown in 
Figure 2.9. The rain flap is water resistant, but not waterproof.

Do not block the lower mesh pocket with clothing or other 
supplies. 

Do not use the instrument with the rain flap deployed. The 
instrument may overheat, because the rain flap prevents 
adequate air circulation.
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In bad weather, place the instrument controller into its compartment on the outside of the 
backpack. Turn off both the instrument and instrument controller. Then pull the rain flap out of 
its compartment and over the outside of the pack. 

Figure 2.9: Rain flap 

2.8 Setting Up GPS
If you want to include location data when you collect spectra, you must use a GPS device and 
configure it to work with your instrument controller. If you purchased the instrument controller 
and GPS device from ASD, you should not have to configure anything. You can begin using the 
GPS device as you collect spectra with no additional configuration. See “Using a GPS Device 
While Collecting Spectra” on page 35.

If you purchased your GPS device or instrument controller from a third party, you must configure 
both to use GPS while collecting spectra.

GPS devices communicate with a computer in different ways, depending on the GPS device’s 
and the computer’s available connections. Table 2.2 lists each combination of connection and 
includes the applicable setup steps. 

Rain flap stored in 
backpack

Rain flap covering 
backpack
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Table 2.2: GPS device and instrument controller connection options and setup

GPS 
device 
connection

Instrument 
controller 
connection

Additional 
hardware or 
software Setup required

Serial Serial None 1. Configure the GPS device to output NMEA data.
• See “Configuring the GPS Device” on page 32.

2. Configure the COM port on the instrument controller.
• See “Configuring the Instrument Controller COM 

Port” on page 34.

3. Configure the COM port in RS3.

• See “Configuring the RS3 Software for GPS Use” 
on page 34.

Serial USB USB-to-serial 
converter 
(hardware 
and software)

1. Configure the GPS device to output NMEA data.
• See “Configuring the GPS Device” on page 32.

2. Install the USB-to-serial converter.
• See “Setting Up a USB-to-Serial Converter” on 

page 32.
3. Configure the COM port on the instrument controller.

• See “Configuring the Instrument Controller COM 
Port” on page 34.

4. Set the COM port in RS3.

• See “Configuring the RS3 Software for GPS Use” 
on page 34.

USB USB GPSGate 
Client 
software (free)

1. Configure the GPS device to output NMEA data.
• See “Configuring the GPS Device” on page 32.

2. Install and configure the GPSGate Client software.
• See “Install and Configure the GPSGate Client 

Software” on page 32.
3. Configure the COM port on the instrument controller.

• See “Configuring the Instrument Controller COM 
Port” on page 34.

4. Set the COM port in RS3.

• See “Configuring the RS3 Software for GPS Use” 
on page 34.

Bluetooth Bluetooth None 1. Configure the Bluetooth connection.
• “Configuring a Bluetooth Connection” on 

page 33.
2. Configure the COM port on the instrument controller.

• See “Configuring the Instrument Controller COM 
Port” on page 34.

3. Set the COM port in RS3.

• See “Configuring the RS3 Software for GPS Use” 
on page 34.
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Configuring the GPS Device
If you purchased your GPS device from ASD, it should already be configured properly. 

If you purchased your GPS device from a third party, you must configure the GPS device output 
format, based on the type of connection you are using:

 Serial or USB-to-serial connection—Configure the GPS device to output National 
Marine Electronics Association (NMEA) 018 GGA text. 

 USB connection

• Garmin® devices—Configure to use the GPSGate Client Interface option.

• Other GPS devices—Configure to use the NMEA format, but it may require 
additional configuration to communicate with RS3.

 Bluetooth connection—No configuration needed. Bluetooth GPS devices automatically 
output in NMEA format.

Consult the documentation for your device for how to configure it for the output needed. 

Setting Up a USB-to-Serial Converter
If you purchased your GPS device and instrument controller from ASD, they should already be 
configured properly. 

If you purchased your instrument controller or GPS device from a third party and your GPS 
device outputs serial data and your computer does not have a serial connection, you must 
purchase a USB-to-serial converter. The NMEA format sends data in a serial format. Most 
computers no longer have serial connections, but a USB-to-serial converter lets you use a USB 
connection with a serial GPS device.

To set up a USB-to-serial converter:

1. Install the software that came with USB-to-serial converter.

2. Connect the USB-to-serial cable to the USB port on the instrument controller and to the 
GPS device.

• Be sure to select a USB connection on the instrument controller that you normally 
want to use for the GPS device. The configuration is specific to this port. To use a 
different port, you must repeat the port configuration.

Continue the GPS setup process with “Configuring the Instrument Controller COM Port” on 
page 34.

Install and Configure the GPSGate Client Software
If you purchased your GPS device and instrument controller from ASD, they should already be 
configured properly. 

If you purchased your instrument controller or GPS device from a third party and your GPS 
devices uses a USB connection to your instrument controller, you must install the GPSGate 
Client software. This software “translates” the NMEA serial data from the GPS device to 
communicate through the USB port.
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To install and configure the GPSGate Client software:

1. Download and install GPSGate Client.

• The software is available from: http://gpsgate.com/download.

• Use a second computer to download the GPSGate Client, so the instrument 
controller IP settings are not changed.

2. Turn on the GPS device.

3. Start the GPSGate Client software and start the setup wizard.

4. Accept the defaults on the first screen and click Next.

• The wizard should find the GPS device and list it by name.

5. In the Select Output window of the wizard, deselect the option related to nRoute/
MapSource and click Next.

6. Note the numbers of the COM ports listed in the Summary window and click Finish.

• The GPSGate icon displays in the system tray (lower-right corner of your screen) and 
is one of the following colors:

• Green—GPSGate detects a valid GPS position.

• Yellow—GPSGate detects valid GPS data, but the GPS data has no fix, that is, it 
cannot determine its position.

• Red—GPSGate does not detect valid GPS data.

Continue the GPS setup process with “Configuring the Instrument Controller COM Port” on 
page 34.

Configuring a Bluetooth Connection
If you purchased your instrument controller or GPS device from a third party and your GPS 
device uses Bluetooth, you must set up the Bluetooth connection.

To configure a Bluetooth connection:

1. Turn on the GPS device and make sure it is discoverable.

• Refer to the documentation for the GPS device.

2. Enable Bluetooth on your instrument controller.

• How you do this varies by computer/Bluetooth combination.

• On a Lenovo™ laptop, press and hold Fn and press F5, then click Power On next to 
Bluetooth Radio. This puts a Bluetooth icon in your system tray (lower-right corner 
of your screen.) 

3. On the instrument controller, display the Add a Device window. 

• How you do this varies by computer/Bluetooth combination. The following should 
work on Windows 7 computers: Select Start > Devices and Printers, then click Add 
a Device.

• On a Lenovo laptop, click the Bluetooth icon in the system tray and select Add a 
Device. 

4. Select your GPS device and click Next. 
33 Chapter 2: Using and Maintaining the Instrument

http://gpsgate.com/download


  
5. Enter the device’s pairing code and click Next.

• Refer to the documentation for the GPS device.

• A message tells you that the device was added successfully.

6. Click Finish.

Continue the GPS setup process with “Configuring the Instrument Controller COM Port” on 
page 34.

Configuring the Instrument Controller COM Port
If you purchased your GPS device and instrument controller from ASD, they should already be 
configured properly. 

If you are setting up an instrument controller purchased from a third party, you must configure 
the COM port for the GPS device.

If your GPS device is not communicating with the RS3 software, check the COM port as 
described below.

To configure the instrument controller COM port:

1. With the instrument controller turned on, connect to your GPS device.

• For USB connections, be sure to select a USB port on the instrument controller that 
you normally want to use for the GPS device. The configuration is specific to this 
port. To use a different port, you must repeat the port configuration.

2. Turn on the GPS device.

3. From the instrument controller, select Start > Control Panel.

4. Click Hardware and Sound.

5. Click Device Manager.

6. Double-click Ports (COM & LPT).

7. Select the port you want.

• If you are using a USB-to-serial cable, select the port that says something similar to: 
USB-to-Serial COMM Port (COMx).

• If you are using Bluetooth, select one of the Bluetooth ports.

8. Verify that the port number is between 1 and 9.

• The port number is in parentheses. For example, it may show (COM4). If the number 
is higher than 9, you must change the port number. The RS3 software only supports 
port numbers between 1 and 9.

9. If you need to change the port number, right-click the port, select Properties, click the 
Port Settings tab, click Advanced, select a new number from the COM Port Number 
drop-down list, and click OK.

• Select a number that is not in use.

Continue the GPS setup process with “Configuring the RS3 Software for GPS Use” on page 34.

Configuring the RS3 Software for GPS Use
If you purchased your GPS device and instrument controller from ASD, they should already be 
configured properly. 
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If you purchased your instrument controller from a third party, you must set up the RS3 software 
to communicate with the correct port.

If you are not seeing GPS data in the RS3 software, make sure the COM port number in the 
software matches the COM port set up in Device Manager. See “Configuring the Instrument 
Controller COM Port” on page 34.

The default COM port settings usually work, but if you require unique GPS settings, look in the 
documentation for your GPS device for the following information:

 Baud rate

 Data bits

 Parity

 Stop bits

To configure RS3 software for GPS use:

1. Start the RS3 software.

2. Select GPS > Settings.

3. From the Port drop-down list, select the COM port number that corresponds to the port 
you found or set up in the Device Manager.

• See “Configuring the Instrument Controller COM Port” on page 34.

4. Based on the information for your GPS device, change the other settings in the GPS 
Settings window to match the device.

5. Click OK.

6. Select GPS > Enabled.

• Be sure you see a check mark next to Enabled. This turns on the GPS function in the 
software.

• Your GPS device and instrument controller are now ready for use. See “Using a GPS 
Device While Collecting Spectra” on page 35.

Using a GPS Device While Collecting Spectra
If you purchased the GPS device and instrument controller from ASD or if you have already 
completed the GPS setup, you can now use the GPS device while you collect spectra. 

Be sure that you have a clear view of the sky to let the GPS device lock on to at least three 
satellites.

To use the GPS device:

1. Connect the instrument controller and GPS device.

2. Turn on the instrument controller.

3. Turn on the GPS device.

4. From the instrument controller, start the RS3 software.

5. Select GPS > Enabled.

• Be sure you see a check mark next to Enabled. This turns on the GPS function in the 
software.
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6. See if the lock icon on bottom-left corner looks locked and if the Latitude, Longitude, 
and Altitude information displays across the bottom of the window.

• You may need to wait a brief period for the GPS device to lock on to three satellites 
for the data to display. Refer to the GPS device documentation for how long this may 
take.

• If you do not see the GPS data, see Table 2.2 on page 31 and refer to the GPS device 
documentation. If the GPS device is showing location data, check that the device is 
set to output NMEA format. See “Configuring the GPS Device” on page 32 and 
check the device documentation.

2.9 Maintaining the Instrument
The following topics describe how to maintain the instrument and white references:

 “Cleaning the Fiber Optic Tip” on page 36

 “Maintaining Spectralon Reference Panels” on page 36

 “Annual Maintenance” on page 37

 “Returning the Instrument for Service” on page 37

Cleaning the Fiber Optic Tip
You can clean the fiber optic tip if it has dirt or debris on it.

To clean the fiber optic tip:

 Use a soft cloth and isopropyl alcohol to clean off the tip. 

Maintaining Spectralon Reference Panels
Spectralon reference panels are an optical standard and should be handled in much the same 
way as other optical standards. Although the reference panel is very durable, take care to 
prevent contaminants such as finger oils from contacting the reference panel’s surface. Always 
wear clean gloves when handling Spectralon reference panels.

To clean a lightly soiled Spectralon reference panel

 If the reference panel is lightly soiled, clean it with a jet of clean dry air or nitrogen. 

According to the manufacturer of the Spectralon reference panel, Labsphere®, use the following 
procedure to clean your heavily soiled Spectralon reference panel.

Sand the Spectralon reference panel under running water with a 220-240 grit waterproof emery 
cloth or sandpaper until the surface is totally hydrophobic (water beads and runs off 
immediately). 

Do not use any freon or compressed gas with freon propellant 
to clean or dry a Spectralon panel. Freon will damage the 
Spectralon surface.
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To clean a heavily soiled Spectralon reference panel:

1. Use a flat surface, such as a thick, flat piece of glass.

2. Place the glass into the sink.

3. Place 220 grade wet sandpaper onto the glass.

4. Gently move the Spectralon reference panel in a figure-eight motion on the sandpaper, 
using water as needed to wash away the thin layer that is sanded off. 

5. Blow dry with clean air or nitrogen or allow the reference panel to air dry. 

6. If the reference panel requires high resistance to deep UV radiation, do one of the 
following:

• Flush the reference panel with >18 milli-ohm distilled, de-ionized water for 24 
hours.

• Vacuum bake the reference panel at 75° C for a 12-hour period at a vacuum of 
1 Torr or less. Then purge the vacuum oven with clean dry air or nitrogen.

Annual Maintenance
ASD recommends that the instrument be serviced once a year. This will ensure the proper 
functioning of the instrument. Annual maintenance is covered for the first year under the ASD 
warranty. Extended warranties also cover annual maintenance, or you can purchase additional 
years of maintenance at the time of service. To purchase annual maintenance or an extended 
warranty, contact your sales representative. 

Returning the Instrument for Service
To return the instrument to ASD for maintenance or repair, contact ASD technical support for a 
Return Merchandise Authorization (RMA). The RMA includes scheduling details, contact 
information, shipping instructions, and a brief description of the maintenance or repair 
requirements. For contact information, see “Technical Support” on page 2. 
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Chapter 3: Troubleshooting

The following sections will help you troubleshoot the instrument:

 “3.1 Common Communication Fixes” on page 38

 “3.2 Instrument Controller Does Not Connect to the Instrument with the Ethernet Cable” 
on page 41

 “3.3 Instrument Controller Does Not Connect Wirelessly to the Instrument” on page 43

 “3.4 Instrument Loses its Wireless Connection” on page 43

 “3.5 Windows Firewall Messages Display When You Try to Connect” on page 44

 “3.6 ASD Software Displays Saturation Error” on page 45

 “3.7 Instrument Needs Updated Firmware or .ini File” on page 45

3.1 Common Communication Fixes
To fix many communication errors (particularly if the instrument has been functioning at some 
point), below are steps to try:

1. If you did not purchase the instrument controller from ASD or have configured the 
instrument controller to connect to a network, you must change the instrument 
controller’s network settings to connect to the instrument.

• See “Changing the Network Settings on the Instrument Controller” on page 39.

2. Power cycle the instrument and/or the instrument controller. 

3. Make sure the Wi-Fi/Ethernet button is in the correct position for the type of connection 
you want:

• Black (button out) for an Ethernet connection with a cable.

• Green (button in) for a wireless connection.

4. For a wireless connection, make sure you have a clear line of sight between the 
instrument and instrument controller. 

• Obstructions between the instrument and instrument controller or radio frequency 
interference in close proximity can cause loss of communication or significantly 
shorten the communication range.

• The instrument uses industry-standard components. You should see the same 
general connection speed and distance capabilities as other wireless devices. 

5. For a wireless connection, make sure the wireless function is turned on.
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• The instrument controller may have a switch on the side of the instrument controller 
that turns the wireless function on and off. Other controllers may use a software 
switch (typically located on the keyboard’s Function keys) to control the wireless 
connection. Be sure the wireless function is turned on.

6. If you receive a 400 command error while starting the ASD software, you need to reload 
the instrument .ini file to the instrument. 

• Use the Instrument Configuration utility from ASD to do this. Contact technical 
support for assistance. 

Changing the Network Settings on the Instrument 
Controller 
If you did not purchase the instrument controller from ASD, you must configure the instrument 
controller’s network settings to work with the instrument. If you changed the instrument 
controller’s network settings to connect to a network, you must change them back to connect to 
the instrument.

The default IP addresses that you need to configure for the instrument controller are:

 Wireless—10.1.1.76

 Ethernet—10.1.1.10

You must also change the user account control settings to avoid communication errors.

To change the user account control settings:

1. Select Start > Control Panel.

2. Click User Accounts.

3. Click the Change User Account Control settings link (bottom of the list at the center).

4. Move the slider to “Never notify” (all of the way to the bottom). 

5. Click OK. 

6. In the upper-left corner, click the Control Panel Home link to return to the Control Panel.

To change the network settings on the instrument controller:

1. Connect an Ethernet cross-over cable to the instrument controller’s Ethernet port and to 
the back of the instrument.

2. From the Control Panel, click Network and Internet.

3. Click Network and Sharing Center.

4. On the left side, click the Change adapter settings link. 

5. Right-click the Local Area Connection and select Properties. 

6. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties. 

Wireless function switch. Be 
sure it is on for wireless 
communication.
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7. Select the “Use the following IP address” option and enter 10.1.1.10 as the IP address 
and 255.255.255.0 as the Subnet mask. 

• All other entries can stay blank. 

8. Click OK twice to return to the Network Connections window. 

9. Right-click the Local Area Connection again and select Properties. 

10. Click Configure in the upper-right side of the window. 

11. Click the Power Management tab.

12. Deselect the “Allow the computer to turn off this device to save power” option. 

13. Click OK to return to the Network Connections window. 

14. Right-click the Wireless Network Connection and select Properties. 

15. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties. 

16. Select the “Use the following IP address” option and enter 10.1.1.76 as the IP address 
and 255.255.255.0 as the Subnet mask. 

• All other entries can stay blank. 
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17. Click OK twice to return to the Network Connections window.

18. Right-click the Wireless Network Connection again and select Properties. 

19. Click Configure in the upper-right side of the window. 

20. Click the Power Management tab.

21. Deselect the “Allow the computer to turn off this device to save power” option. 

22. Click OK to return to the Network Connections window. 

23. In the upper-left corner of the window’s title bar, click the back button twice to return to 
the Control Panel.

3.2 Instrument Controller Does Not Connect to 
the Instrument with the Ethernet Cable

1. See the section: “3.1 Common Communication Fixes” on page 38.

2. Check that the Ethernet cable is securely connected to the instrument and instrument 
controller. 

3. Check that the Ethernet LED near each connection is on.

4. Check that the Ethernet cable is a cross-over Ethernet cable.

The instrument can have only one active network connection 
(Ethernet or wireless) at a time. The Wi-Fi/Ethernet button on the 
back of the instrument controller determines the active connection. 
When the button is green, the wireless connection is enabled. 
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5. Check that the IP addresses of the instrument and the instrument controller are in the 
same range or subnet. 

• The same range or subnet means that the first three octets of the IP address 
(xxx.xxx.xxx.___) match.

• The default IP address for the instrument is 10.1.1.11.

• The default subnet mask is 255.255.255.0. 

• The instrument controller must have a corresponding, unique IP address in the same 
range as the instrument, such as 10.1.1.x where x is a unique number. The subnet 
mask must be the same as the instrument, such as 255.255.255.0.

6. Do a ping test to make sure the instrument is responding. 

• Open up a command window by selecting Start > Run 

• Type cmd in the Run window.

• Click OK. 

• For an Ethernet connection, type: ping 10.1.1.11

• For a wireless connection, type: ping 10.1.1.11 

Successful 
ping example
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3.3 Instrument Controller Does Not Connect 
Wirelessly to the Instrument 

1. See the section: “Common Communication Fixes” on page 38.

2. Disconnect the Ethernet cable from the instrument controller and instrument, then turn 
the instrument off and back on.

3. Press the Wi-Fi/Ethernet button to make it green, indicating the instrument controller is 
configured for a wireless connection.

• The button toggles between black (button out) for Ethernet and green (button in) for 
wireless.

4. Connect the instrument controller to the instrument’s wireless connection. 

• Click the wireless icon  in the lower-right corner of your screen.

• If you do not see the icon, select Start > Control Panel, click Network and 
Sharing Center, click Connect to a Network.

5. Select the connection you want and click Connect.

• If you are using encryption, make sure you are using the same WPA (security) key as 
set for the connection.

• The instrument has a default WPA of: 0123456789

•  When first connecting to the instrument, the connection status may show, “Limited 
access.” After you start the ASD software, the status will change to, “Connected.” 

3.4 Instrument Loses its Wireless Connection 
1. See section “Common Communication Fixes” on page 38.

2. Try to minimize the radio frequency noise in your environment. 

• Radio frequency noise interference can come from: 2.4 GHz cordless phones, 
microwaves, monitors, electric motors, ceiling fan, lights, security systems, etc. 

List of available wireless 
connections. 

The default connection for the 
instrument is the instrument’s 
serial number.
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3. Minimize obstructions between the instrument and the instrument controller. 

• Positioning of the instrument and instrument controller can affect the wireless range. 
Walls, ceilings, doors, buildings, hills, etc. can degrade the signal. 

3.5 Windows Firewall Messages Display 
When You Try to Connect

The Windows firewall must be set to permit connections to specific ports on the instrument 
controller. Without these inbound and outbound rules for the ports, the firewall displays 
messages when you try to connect and when you try to configure the network settings using the 
ASD IP Setup software.

You may want to contact your network administrator about these settings.

To troubleshoot the Windows firewall:

1. Select Start > Control Panel. 

2. Click System and Security.

3. Click Windows Firewall.

4. Click Advanced Settings.

5. Click Inbound Rules.

6. Make sure you see the two ASD rules.

7. Click Outbound Rules.

8. Make sure you see the two ASD rules.

9. If the rules are there, but are not enabled, right-click each rule and select Enable Rule.

10. If these rules are not listed at all, you must add them using the following settings:

• Inbound rule settings:

• Port, TCP, port number 8080, allow the connection, select Domain, Private, and 
Public, and give it a name you will recognize.

• Port, UDP, port number 20034, allow the connection, select Domain, Private, 
and Public, and give it a name you will recognize.
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• Outbound rule settings:

• Port, TCP, port number 8080, allow the connection, select Domain, Private, and 
Public, and give it a name you will recognize.

• Port, UDP, port number 20034, allow the connection, select Domain, Private, 
and Public, and give it a name you will recognize.

3.6 ASD Software Displays Saturation Error
The ASD software displays a saturation error and plays an audible error alarm when the 
instrument is overwhelmed with light (signal) and cannot discern the spectrum of the sample. 

Saturation does not damage the instrument, but collection while in the saturation state will result 
in inaccurate data.

To resolve the software saturation error:

1. Click Opt to optimize the instrument in the RS3 software.

• The optimization is complete when the Spectrum Avg progress bar resumes.

2. Click WR to take a white reference.

3. Collect spectra from the sample.

4. If the saturation error continues, contact ASD technical support.

• Depending on the specific situation, you may need an attenuator attachment, 
available from ASD, to resolve the error.

3.7 Instrument Needs Updated Firmware 
or .ini File

The Instrument Configuration utility from ASD can automatically perform the following 
functions:

 Update the instrument’s firmware.

• Use only when directed to do so by ASD support personnel.

 Update the instrument’s .ini file.

• Use only when directed to do so by ASD support personnel.

You can also do the following manually using the Configuration Utility:

 Update the instrument’s firmware.

• Use only when directed to do so by ASD support personnel.

 Update the instrument’s .ini file.

• Use only when directed to do so by ASD support personnel.
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Appendix A: Specifications and 
Compliance

The following sections contain the specifications and WEEE compliance:

 “A.1 Physical Specifications” on page 46

 “A.2 Power Input and Output” on page 47

 “A.3 Battery Specifications” on page 47

 “A.4 Battery Charger Specifications” on page 47

 “A.5 Environmental Specifications” on page 48

 “A.6 Wavelength Configuration” on page 48

 “A.7 Network Interface Requirements” on page 49

 “A.8 WEEE Compliance” on page 49

 “A.9 Certifications” on page 49

A.1 Physical Specifications
Below are the physical specifications of the instrument.

 

 Enclosure is made of durable satin powder-coat finish with urethane end-caps and 
handles.

 All vital components are in a dust-proof enclosure and EMI sealed.

 Fiber optic inputs directly to the instrument. 

Height 12.7 cm 5 inches

Width 36.8 cm 14.5 inches

Depth 29.2 cm 11.5 inches

Weight 5.44 kg 12 lbs 
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A.2 Power Input and Output
Below are the power input and output.

A.3 Battery Specifications
Below are the NiMH battery specifications.

* Battery life may be affected by high or low temperatures. 

A.4 Battery Charger Specifications
Below are the battery charger specifications.

AC power supply type Auto ranging, Switching, SELV

AC input 90-240 VAC, 50/60 Hz 

DC input +12 VDC, 60 W

Accessory power port 
(front of instrument) 

Output, +12 VDC, 27 W (max).

Type NiMH (Nickel-Metal Hydride)

Rating 12 V, 9 amp hour

Life Over four hours using a contact probe in an
ambient environment.

Recycle batteries and do not dispose of as 
general waste.

Type External desktop

AC input 90-240 VAC, 50/60 Hz

Charge time Under 8 hours for a fully discharged 9 AH battery
47 Appendix A: Specifications and Compliance



  
A.5 Environmental Specifications
Below are the environmental specifications.

A.6 Wavelength Configuration
Below is the wavelength configuration.

The spectral resolution is:

 3 nm @ 700 nm.

 30 nm @ 1400 nm for the Wide-Res model, 10 nm for Standard-Res, 8 nm for High-Res, 
and 6 nm for Hi-Res NG.

 30 nm @ 2100 nm for the Wide-Res model, 10 nm for Standard-Res, 8 nm for High-Res, 
and 6 nm for Hi-Res NG. 

The sampling interval is:

 1.4 nm for the spectral region 350-1000 nm. 

 2 nm for the spectral region 1001-2500 nm. 

The spectrometer is configured to have three separate holographic diffraction gratings with three 
separate detectors. Each detector is also covered with the appropriate order separation filters to 
eliminate second and higher order light.

 VNIR: 512 element silicon photo-diode array for the spectral region 350 to 1000 nm.

 SWIR 1: graded index, TE-cooled, extended range, InGaAs, photo-diode for the spectral 
region 1001 nm to 1800 nm. 

 SWIR 2: graded index, TE-cooled, extended range, InGaAs, photo-diode for the spectral 
region 1801 nm to 2500 nm. 

Operating temperature 0 to 40°C

Operating and storage humidity Non-condensing

Storage temperature -15 to 45°C

Wavelength name Wavelength range 

VNIR-SWIR 1-SWIR 2 350 - 2500 nm
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A.7 Network Interface Requirements
The instrument has a 10/100 Base T Ethernet port. You can connect the instrument to the 
instrument controller using an Ethernet cross-over cable.

The instrument can also communicate with the instrument controller using the 802.11g wireless 
card. If you are not using the instrument controller that comes with the instrument, the 
instrument controller needs to be 802.11g compatible.

A.8 WEEE Compliance
 Recycle. Items with this symbol indicate that the item should be recycled and not 
disposed of as general waste.

A.9 Certifications
 CE certified

 NIST traceable calibration

 21 CFR, Part 11 (installed per customer request)

 USP 1119 (installed per customer request and purchase of applicable USP Standards)

Conforms to the following EU Directives:

 Safety: Low Voltage Directive, 2006/95/EC

 EMC: Electromagnetic Compatibility Directive, 2004/108/EC

The product complies with the requirements of the following Harmonized Product Standards 
and carries the CE-Marking accordingly:

 EN61010-1:2001 2nd Edition—Safety Requirements for Electrical Equipment for 
Measurement, Control and Laboratory use

 EN61326-1:2013 Basic—Class A, Electrical Equipment for Measurement, control and 
Laboratory use-EMC Requirements
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Appendix B: FAQs

The following sections will help you with questions about the FieldSpec®4 instrument:

 “B.1 General” on page 50

 “B.2 Collecting Spectra” on page 52

 “B.3 Working with Data” on page 55

 “B.4 Network and GPS” on page 58

 “B.5 Instrument Controller” on page 59

B.1 General
 “What Is a Spectrometer?” on page 50

 “How Long Does It Take for the Instrument to Warm Up?” on page 50

 “What Does a Broken Fiber Mean?” on page 51

 “How Long Is the Battery Life?” on page 51

 “Where Is My Serial Number?” on page 51

What Is a Spectrometer?
Spectrometer — An optical instrument that uses detectors, other than photographic film, to 
measure the distribution of radiation in a particular wavelength region. All ASD instruments are 
spectrometers. The SWIR component of the ASD spectrometer is a scanning spectrometer, while 
the VNIR component is an array spectrometer.

Spectroradiometer — An optical instrument for measuring the radiant energy (radiance or 
irradiance) from a source at each wavelength throughout the spectrum. A spectroradiometer is a 
special kind of spectrometer. 

Spectrograph — An optical instrument for forming the spectrum of a light source and recording 
it on a film. The dispersing medium may be a prism or a diffraction grating. This term was 
common prior to the digital age. ASD instruments do not use film.

How Long Does It Take for the Instrument to Warm 
Up?
The warm-up time of the instrument depends on the environment in which it is used. 
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One hour is recommended for radiometric work. 

Only 15 minutes is needed for reflectance measurements, especially if you need to conserve the 
battery life. 

What Does a Broken Fiber Mean?
A few broken fibers are not critical when measuring reflectance, because reflectance is a relative 
measurement. However, if too many fibers are broken, the signal decreases too much and the 
spectra will be excessively noisy. How many broken fibers are too many depends on the 
application and the types of samples you are using the instrument with.

Radiance and irradiance are measured using the raw data and comparing to numbers that exist 
in the calibration file. Therefore, a few broken fibers will result in lower values.

The fibers are well protected by the cable casing. If there are kinks in your cable, the fibers are 
not necessarily damaged. However, if your cable has been severely damaged, chances are high 
that the fibers have been damaged, too. To determine if any fibers are broken, see “Checking the 
Fiber Optic Cable for Broken Fibers” on page 14.

The fibers can be damaged by coiling the cable up too tightly. If left in a tight coil for longer than 
a week, the fibers are likely to develop longitudinal fractures that will not be detectable. These 
fractures in the fiber will cause light leakage, resulting in a weaker signal. Store the fiber optic 
cables loosely in the netting compartment on the instrument.

How Long Is the Battery Life?
A fully charged NiMH battery’s life depends on the battery age, instrument configuration, 
environment, and accessories powered by the accessory power port. The expected battery life is 
over four hours using a contact probe in an ambient environment.

The limiting factor for how long you can work in the field may be the battery in the instrument 
controller rather than the instrument’s battery.

Where Is My Serial Number?
The serial number is a five-digit number located on a label on the back of the instrument where 
the power switch is, as shown in Figure B.1. The label also contains the model number and MAC 
address for the instrument.

The serial number is also accessible in the ASD software by selecting Help > About. When 
corresponding with ASD about any instrument questions, you should provide the instrument 
serial number.

The fiber cable should never be stored with a bend of less than 
a 5" diameter for long periods of time.
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Figure B.1: Label with serial number

B.2 Collecting Spectra
 “How Often Do I Need to Optimize?” on page 52

 “How Often Do I Need a Baseline or White Reference?” on page 53

 “What Spectrum Average (or Sample Count) Should I Use?” on page 53

 “How Do I Collect a Reference with a Spot Size Larger Than the Spectralon Panel?” on 
page 54

 “When Do I Use Absolute Reflectance?” on page 54

 “How Do I Know the Field of View That I’m Using?” on page 54

 “What Are the Units of Radiance?” on page 55

How Often Do I Need to Optimize?
Optimization is the process of setting the instrument’s electronics to optimally process the 
incoming signal. This means that the digitalization of the light signal is within a range of values 
that provide good signal-to-noise performance and does not allow the instrument to saturate at 
the current light levels. 

The instrument must be re-optimized if:

 Atmospheric conditions change.

 The light source changes.

 The instrument is in the process of warming up and the response changes substantially.

 The instrument is saturating.

Outdoor conditions can change rapidly or slowly. It all depends on clouds, wind (affecting 
temperature), instrument warm-up time, etc.

Use the Spectralon reference panel when optimizing and for taking a white reference 
measurement. The position of the reference panel when taking a white reference should be as 
similar as possible to the position for collecting data from the samples.
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When saving reflectance data, point the fiber optic cable at the Spectralon panel once every few 
measurements for a minute or two with the same viewing geometry. If the relative reflectance of 
the Spectralon panel is less than or greater than one, a new white reference may be needed. If 
the relative reflectance of the Spectralon panel is greater than one, reoptimization is 
recommended.

The ASD software provides a saturation warning. We recommend leaving the volume on the 
instrument controller loud enough to hear the warning.

How Often Do I Need a Baseline or White 
Reference?

Inside Use or Using an Accessory Light Source
When using the instrument inside under constant lighting conditions or when using an 
accessory with its own light source, collect a white reference every 10 to 15 minutes while the 
instrument is warming up and every 30 minutes thereafter.

Outside Use
When using the instrument outside, you should collect a new white reference at least every ten 
minutes. 

The more frequent the white references, the better the resulting reflectance spectra will be. You 
need more frequent white references outdoors because of changing illumination, atmospheric 
conditions, and temperatures. 

The light intensity when collecting the white reference should be the same when collecting 
spectra of samples.

When outside, continue to take measurements of the white reference panel and observe the 
stability of the white reference line. This will give you an idea of how the current fluctuations in 
weather affect your measurements.

What Spectrum Average (or Sample Count) Should 
I Use?
The default averages are as follows:

 Spectrum—10

 Dark current—100

 White reference—25

When outside, these defaults may work well for you. In general, we suggest that the white 
reference be set to about double the spectrum and dark current averages.

The noise decreases at the square root of the number of scans used in the averaging.

The actual spectrum average will be a compromise between noise reduction through spectra 
averaging and the time required for each spectral collection. For example, if you are using the 
instrument to measure a large number of samples, you want a smaller number of spectra in the 
average to decrease the collection time required. If you are collecting a few spectra, you'll want 
to increase the number of spectra in the averaging to obtain the cleanest spectra possible. When 
building models, the number should stay constant regardless of the number of samples.
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How Do I Collect a Reference with a Spot Size 
Larger Than the Spectralon Panel?
Purchase a bigger reference panel or move the fiber optic cable closer to it.

If you are indoors using artificial light, make sure that the distance and angle from the reference 
panel is the same as for samples.

If you are outdoors and the sun is your light source, the reference panel can be closer to the fiber 
optic cable than the samples.

When Do I Use Absolute Reflectance?
It depends on how you are analyzing your data. An absolute reflectance most likely will not be 
needed when using an accessory with its own light source.

There are no negatives to using absolute reflectance. The difference between absolute and 
relative reflectance is small for wavelengths less than 2000 nm.

Because relative reflectance relies on a physical white reference, you will see deviations from 
the absolute wavelength ranges 350-400 nm and 2000-2500 nm.

How Do I Know the Field of View That I’m Using?
The field of view is labeled on the fore optic that you use. The bare fiber has a 25° field of view.

When you are measuring radiance, set the correct field of view in the RS3 software using the fore 
optics drop-down list.

Figure B.2: Spot size diagram

D = effective diameter of fore optic lens

A = fore optic’s angular field of view

X = distance to viewed surface

Y = diameter of field-of-view

Near field (less than 1 meter):
FieldSpec® 4 User Manual 54



  
Y = D + 2 * X * Tan(A/2)

Far field (greater than 1 meter):

Y = 2 * X * Tan(A/2)

What Are the Units of Radiance?
Radiance is measured in Watts per square meter per steradian (W/m2/sr). 

However, the instrument measures spectral radiance, which is the amount of radiance per unit 
wavelength. Spectral radiance is measured in Watts per square meter per steradian per 
nanometer (W/m2/sr/nm).

Reflectance and transmission measurements are ratios of the optical energy from a sample 
compared to the optical energy from a reference panel. The units cancel out, so these 
measurements do not use the calibration files to calculate radiance.

The instrument measures irradiance in Watts per square meter per nanometer (W/m2/nm).

B.3 Working with Data
 “Can I Post-process My Data?” on page 55

 “Why Do I See Oscillations (Sine Wave) in My Data?” on page 55

 “What Are These Two Large Noise Bands in My Data?” on page 56

 “What Are These Upward or Downward Spikes in VNIR Data?” on page 56

 “What Are These Steps in My Data?” on page 57

 “What Can Cause More Noise in My Data from Last Time?” on page 57

 “Why Does the VNIR Drop to Zero after a Dark Current Collection?” on page 58

 “How Can I Convert My Data?” on page 58

Can I Post-process My Data?
Yes. The ViewSpec Pro software is one of many programs that can post-process your data. You 
can import the spectral data into many different programs or export to ASCII text files for 
incorporation into other applications. 

The complete specification of the ASD file format is available upon request.

Why Do I See Oscillations (Sine Wave) in My Data?
Your light source may use AC power. A single SWIR scan is about 100 ms. If you observe five or 
six waves in a single SWIR detector, the AC light source is the cause.

Waves can also occur if the lamp reflector and/or cover glass behave as a white-light 
interferometer. Solution: remove the glass and/or use a more diffuse reflector.
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What Are These Two Large Noise Bands in My 
Data?
Water vapor in the atmosphere absorbs light in the 1400 nm and 1800 nm bands. This results in 
little to no signal at these wavelengths. When the reference and target spectra are ratioed to 
create reflectance measurements, very small, randomly fluctuating numbers (that is, noise) 
create large fluctuations in the spectra.

Figure B.3: Examples of water vapor absorbing light

Information on other causes of absorption bands is available in “D.2 Atmospheric 
Characteristics” on page 64.

What Are These Upward or Downward Spikes in 
VNIR Data?
Figure B.4 shows upward spikes resulting from artificial light sources, in particular fluorescent 
lights. 
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Figure B.4: Spectrum of fluorescent lights.

What Are These Steps in My Data?
Light is brought into the instrument by various combinations of the strands in the fiber optic 
cable. Each strand has its own field of view. When the cable is held close to the sample, each 
strand views slightly different portions of the sample. This can result in the stepped data. 

Hold the end of the fiber cable farther away from the sample to allow the field of view of the 
individual strands to overlap and mesh together.

Stepping of data is common when the fore optic has a lens and less common when using the 
bare fiber optic cable or sampling devices. Large persistent steps can indicate broken fibers. The 
ViewSpec Pro software can remove large steps in reflectance data through the Splice Correction 
utility.

What Can Cause More Noise in My Data from Last 
Time?
Many factors can cause noise in your data from one session to another. Noise in a measurement 
is related to the instrument, the signal level, and noise in the light source. Many times the 
appearance of noise is actually a decrease in the strength of the signal, as opposed to an 
increase in noise. 

Under normal operating conditions, noise visible in a spectrum is always the result of a trade-off 
between the inherent noise in the system and the signal. 

The angle of the sun at high noon in the fall has a reduced light level compared with high noon 
in summer. Likewise, the time of day and the sun’s position affect light levels, as well as 
atmospheric conditions.

Also, broken fibers in the fiber optic cable can contribute to noise. Perform a fiber optic check to 
verify. See “Checking the Fiber Optic Cable for Broken Fibers” on page 14.
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An increase in noise can be due to a problem in the instrument such as an electronic component 
malfunction or a grounding problem. This is usually indicated by a regular pattern to the noise 
or periodic bursts of noise that are visible over the normal spectra. 

Why Does the VNIR Drop to Zero after a Dark 
Current Collection?
When the VNIR drops to zero after a dark current has been collected, this may indicate a 
problem with the dark current calibration file or dark current collection routine. 

To verify, observe if you have both of the following:

 A normal response curve in the VNIR region before optimizing or before taking a dark 
current. 

 A flat line displayed after the optimization/dark current routine completes. 

If you do not obtain a normal response curve in the VNIR region, contact technical support.

How Can I Convert My Data?
The ViewSpec Pro software can convert spectral data to ASCII text files and several other file 
formats. Conversion can be done one file at a time, or several files can be merged into a single 
text file.

B.4 Network and GPS
 “How Do I Set Up GPS?” on page 58

 “What Type of Ethernet Cable Can I Use for the Static IP Configuration?” on page 58

How Do I Set Up GPS?
See “2.8 Setting Up GPS” on page 30.

What Type of Ethernet Cable Can I Use for the 
Static IP Configuration?
You can connect the instrument directly to the instrument controller using an Ethernet cross-over 
cable.

When the instrument and instrument controller communicate over a network, use standard 
Ethernet cables and IP addresses compatible with the network. The instrument imposes 
significant traffic on the network, which can cause packet delays to other users. More 
importantly, network traffic from other users can negatively impact the reliability of the 
communication between instrument and instrument controller.
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B.5 Instrument Controller
 “Can I Install Additional Software on the Instrument Controller?” on page 59

 “Why Does the Software Seem to Do Unexpected Things?” on page 59

Can I Install Additional Software on the Instrument 
Controller?
Yes, but with qualifications.

The types of software that can interfere with the measurement of data are utilities, network 
software, and those working in the background, such as virus checkers.

ASD software requires real-time access to the data that is being streamed from the instrument at 
a high rate of speed. Software running in the background can cause packets to be lost.

Microsoft Office software, image processing software, and other software generally do not 
interfere with ASD software, particularly if they are not running and competing for CPU cycles 
and RAM at the same time that data is being collected from the instrument.

Why Does the Software Seem to Do Unexpected 
Things?
To ensure accuracy in the collection and processing of data, the ASD software finishes its current 
operation before moving on. The instrument outputs a lot of data at a high rate of speed for the 
ASD software to collect. 

In addition, the ASD software will stack up your keystroke entries and execute them later, in the 
order they were received.

Wait for the collection to finish before entering the commands to launch another operation. Do 
not rush into new operations or into issuing new commands until you see the results of the 
current command.
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Appendix C: Standard Accessories

 FieldSpec 4 User Manual (printed and PDF on flash drive)

 FieldSpec 4 Quick Start Guide (printed and PDF on flash drive)

 Instrument power supply 12 V

 One 12 V, 9 amp hour Nickel-Metal Hydride battery, one AC battery charger, and one 
battery-to-instrument power cable.

 DC vehicle power cable (6 m/20 ft) 

• When using this cable, turn off the engine to the vehicle. Electromagnetic fields 
from the engine can generate noise in the acquired signals.

 Remote trigger with LEDs and hook and loop strips

 RJ45 CAT 5e UTP Ethernet, shielded, cross-over cable

 Ergonomic backpack with soft-sided travel bag

 Fiber optic spool

 Pistol grip and pistol grip clip

 Laptop carrier

 Fiber inspection scope/magnifier

 Durable transport/shipping case

 Binder that contains the following: Quality Control documentation, Mylar wavelength 
reference, and USB flash drive loaded with ASD software.

 3.62" diameter Spectralon reference panel

 Bag containing hook and loop straps and instructions

 Bag of fiber optic tip covers
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C.1 Accessories for Light Sources and Probes
ASD offers several accessories for:

 Delivering illumination to the sample.

 Collecting reflected or transmitted light from the sample and transmitting the collected 
light to the instrument.

 Collecting radiance and irradiance data (where solar light is the primary source of 
illumination).

Many accessories, including the optional fore optic lenses, rely on external illumination sources, 
including solar illumination.

Visit the FieldSpec 4 product pages on the ASD website at www.asdi.com to see more 
recommended accessories. 
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Appendix D: Understanding Field 
Measurement Conditions

Field spectrometry is the quantitative measurement of radiance, irradiance, reflectance, or 
transmission in the field. It involves the collection of accurate spectra and requires an awareness 
of the influences of:

 Sources of illumination

 Instrument field of view

 Sample viewing and illumination geometry

 Instrument scanning time

 Spatial and temporal variability of the sample characteristics

Many of these parameters are controlled when using one of the ASD standard sampling 
interfaces (for example., Muglight or contact probe).

To develop a field experiment, you must first define the overall experimental design. 
Unfortunately, the formulation of an appropriate experimental design is not always obvious. 

In light of the objectives of the study, you must consider issues such as the:

 Timing of the data collections

 Spatial scale of the field measurement

 Target viewing and illumination geometry

 Collection of ancillary data sets

A lack of appropriate ancillary data sets may make previously collected data sets unusable for a 
new application. 

Frequently, you must change the experimental design to account for the characteristics of the 
available instrumentation. 

For example, vegetation canopy spectra collected using a slow scanning instrument will 
sometimes have small wind-induced “absorption” features in those portions of the spectra when 
the instrument was viewing more shadow. 

The following sections describe more about collecting spectra in the field:

 “D.1 Illumination” on page 63

 “D.2 Atmospheric Characteristics” on page 64

 “D.3 Clouds” on page 66

 “D.4 Wind” on page 67

 “D.5 Vegetation” on page 67
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 “D.6 Rocks, Soils, and Man-Made Materials” on page 68

 “D.7 White Reference” on page 69

D.1 Illumination
To determine the reflectance or transmittance of a material, two measurements are required:

 The spectral response of a reference sample

 The spectral response of the target material

You must compute the reflectance or transmittance spectrum by dividing the spectral response of 
the target material by that of a reference sample. The ASD software handles both the collection 
of the two spectral responses and the calculation of reflectance or transmittance. 

Using this method, all parameters that are multiplicative in nature and present in both the 
spectral response of a reference sample and the target material, are ratio-ed out, such as:

 The spectral irradiance of the illumination source

 The optical throughput of the field spectrometer

This process assumes that the characteristics of the illumination are the same for the reference 
and target materials. Variability of the illumination characteristics between the time the 
reference and target materials are measured will result in errors in the resultant spectra.

Characteristics of Natural Illumination
Field spectrometry typically involves ambient solar illumination. As such, the target can be 
illuminated by three or more sources (see Figure D.1), each with its own spectral characteristics. 
Unless the target is in a shadow, the direct solar illumination is the dominant source of 
illumination.

Figure D.1: The major sources of illumination 

You may have several sources of light scattered off surrounding objects, each with its own 
unique spectral distribution.

Parameters such as solar elevation angle and atmospheric conditions will affect the overall 
intensity and spectral characteristics of direct solar illumination. Diffuse skylight illumination 
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can contribute as much as 5-10% of the total illumination reaching a surface. At shorter 
wavelengths, diffuse skylight can contribute as much as 20-25% of the total. 

The spectral characteristics of the illumination scattered off surrounding objects is determined by 
their reflectance characteristics. In the case of a forest clearing, as much as 20% of the 
illumination in the 750-1200 nm wavelength range can be attributed to sunlight scattered off the 
surrounding forest canopy. 

One important source of surrounding scattered light is the person and the instrumentation 
making the measurement. Objects in the surroundings also affect the overall illumination of the 
target surface by obscuring a portion of the diffuse skylight and, possibly, shading the target from 
direct solar illumination.

The magnitude of both the diffuse skylight and scattered light is determined by the solid angle 
subtended by these sources when viewed from the reference frame of the target surface. 

The surface texture of the material being measured also affects the relative portion of the various 
sources of illumination. When compared to a smooth surface, a surface with a rough texture will 
tend to have a higher portion of illumination from the diffuse and scattered light relative to the 
direct solar illumination.

Characteristics of Artificial Illumination
The use of artificial illumination allows: 

 More control over illumination and viewing geometry.

 More control over sample geometry.

 Measurements during non-optimal conditions (for example, cloud cover or at night).

 Measurement of reflectance and transmittance in the deep atmospheric absorption 
bands. 

Several problems with using artificial illumination include: 

 Difficulty in maintaining a constant distance between the sample or reference and the 
light source when measuring samples with irregular geometry.

 “Cooking” vegetation samples under the lights (water loss, chlorophyll degradation). 

In a typical lamp configuration for indoor use, you view the sample with the collecting optics of 
the spectrometer nadir to the sample. Use one or two 200 to 500 Watt quartz-halogen cycle 
tungsten filament lamps (~3400°K color temperature) in housings with aluminum reflectors 
about one meter above the surface being measured.

Alternatively, the light source can be either incorporated into the field spectrometer (often 
precluding the use of solar illumination) or can be provided in the form of an optional accessory 
that mounts to the light collecting optics of the instrument.

D.2 Atmospheric Characteristics
Absorbing molecules in the atmosphere strongly modify the incoming solar irradiance. All of the 
absorption features will increase in intensity as the atmospheric path length of the incoming 
solar radiation increases (e.g. with changing solar elevation angle). 
FieldSpec® 4 User Manual 64



  
By far, water vapor is the strongest modifier of the incoming solar spectrum. Water vapor has 
absorption features spanning the solar reflected region of the spectrum (see Figure D.2), and 
varies both spatially and temporally. 

Figure D.2: Transmission spectrum of water vapor for typical atmospheric conditions

Carbon dioxide has strong features in the 2000-2200 nm range (see Figure D.3), a region of 
major interest for the identification of layered silicate minerals. Carbon dioxide is a well mixed 
gas, thus the intensity of the absorption features associated with carbon dioxide are not as 
variable as those of water vapor, but they do decrease with increasing altitude. 

Figure D.3: Transmission spectrum of carbon dioxide for typical atmospheric conditions.
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Other major atmospheric components that influence the atmospheric transmission spectrum are 
shown in Figure D.4.

Figure D.4: Transmission spectrum of various gases for a typical atmospheric conditions

D.3 Clouds
Partial cloud cover is indicative of highly spatially and temporally variable atmospheric water 
vapor. 

Because of the large influence of water vapor on the atmospheric transmission, variability of 
atmospheric water vapor between the time when the reference and target measurements are 
made will result in errors in the resultant spectrum. 

You can reduce this error by minimizing the length of time between the measurement of the 
reference sample and the target. 

While they are difficult to see and often appear inconsequential, the presence of cirrus clouds 
tends to produce significant variability in atmospheric water vapor. 

Partial cloud cover also greatly increases the intensity of diffuse skylight illumination. This tends 
to “fill in” shadows and reduce the contrast between surfaces with dissimilar surface textures. 

If you want to collect field spectra for image calibration or interpretation, collect spectra under 
illumination conditions similar to those at the time the image was collected.
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Measure the Magnitude of the Effect of Cirrus 
Clouds
Here is a way to measure how much cirrus clouds affect spectra collection:

1. Standardize the field spectrometer on the reference panel.

2. Continue to view the reference panel with the instrument. 

• If the atmospheric conditions are stable, the computed reflectance of the panel will 
be a flat spectrum with near 100% reflectance. 

• If atmospheric conditions are unstable, the computed reflectance of the panel will 
vary over time and will show absorption minima or maxima (depending on whether 
atmospheric water vapor is increasing or decreasing) at the wavelengths 
corresponding to the water vapor absorption features. 

With this method, you can determine if you can collect sufficiently accurate spectral data.

D.4 Wind
Wind can be a source of error if the material being measured moves as you collect spectrum. 

If a spectrum is slowly scanned, changes in the amount of shadow in the instrument field of view 
will result in erroneous “features” in the spectrum.

Vegetation canopies, with their large portion of shadow, are especially susceptible to wind-
induced errors. 

Instruments using an array detector or that scan the spectrum rapidly are not significantly 
affected by wind.

D.5 Vegetation
The absorption features seen in vegetation spectra are all related to organic compounds 
common to the majority of plant species. 

Thus, the information about a plant canopy is contained in the relative intensity of the various 
absorption features, rather than in the presence or absence of a specific absorption feature. 

The major spectral absorption features can be attributed to:

 Water 

 Plant pigments

• Chlorophyll

• Zanthophyll

• Carotenoids

Other, minor, absorption features are attributable to other chemical components, including:

 Cellulose
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 Lignin

 Proteins

 Starches

 Sugars

Non-photosynthetic components of the canopy have spectra that are dominated by absorption 
features attributed to lignin and cellulose.

The spectral radiance leaving a vegetation canopy is significantly impacted by many factors, 
such as those listed in Table D.1.

D.6 Rocks, Soils, and Man-Made Materials
The shape of the spectral signature of rocks and soil tends not to change with respect to the 
viewing geometry. The overall brightness of the observed spectrum does change with 
illumination and viewing geometry, due to changes in the amount of shadow in the field of view 
of the spectrometer. 

Table D.1: Major variables affecting the spectral radiance of a vegetation canopy

Illumination • Geometry
• Angle-of-incidence of sun (or radar)
• Azimuth

• Spectral characteristics

Sensor • Canopy
• Type (plant or tree nominal class)
• Closure
• Orientation

• Systematic (for example, rows)
• Unsystematic (random)

• Crown
• Shape (or example, circular, conical)
• Diameter (m)

• Trunk or stem

• Density (units per m2)
• Tree diameter-at-breast-height: tree trunks or plant stems have a certain 

density.
• Leaf

• Leaf-area-index: defines the area that interacts with solar radiation; the 
surface that is responsible for carbon absorption and exchange with the 
atmosphere.

• Leaf-angle-distribution: may change throughout the day as the leaves orient 
themselves toward or away from the incident radiation.

Understory Same as vegetation

Soil • Texture
• Color
• Moisture content
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Absorption features in the spectra of rocks and minerals are due to the presence of specific 
molecular groups and are often diagnostic of the minerals present in the sample.

D.7 White Reference 
A material with relatively uniform reflectance across the entire spectrum is called a white 
reference panel or reference standard. 

The raw measurement made by the spectrometer is influenced by both the sample and the light 
source. You need an independent measure of the light source illumination on a reference of 
known reflectance to calculate the reflectance of the sample. The use of a white reference 
standard with near 100% reflectance simplifies this calculation.

The ASD software can calculate the ratios for reflectance or transmittance of the material being 
sampled by the spectrometer using the reference panel as the standard.

Spectralon reference standard from Labsphere is the white reference panel that is very suitable 
for the VNIR and SWIR spectral ranges of ASD instruments.

Spectralon reference panels are made of polytetraflouroethylene (PTFE) and cintered halon. It 
has the characteristic of being nearly 100% reflective within the wavelength range of 350 nm to 
2500 nm. A Spectralon white reference scatters light uniformly in all directions within that 
wavelength range.
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Appendix E: Theory of Operation

The following sections describe the instrument’s theory of operation:

 “E.1 Overview” on page 70

 “E.2 Fiber Optic Collection of Reflected/Transmitted Light” on page 71

 “E.3 Inside the Instrument” on page 71

 “E.4 Visible and Near-Infrared (VNIR)” on page 71

 “E.5 Short-Wave Infrared (SWIR)” on page 71

 “E.6 Fore Optics” on page 72

 “E.7 Dark Current Measurement” on page 72

 “E.8 White Reference” on page 73

 “E.9 Gain and Offset” on page 74

E.1 Overview
The instrument measures the optical energy that is reflected by, absorbed into, or transmitted 
through a sample. Optical energy refers to a wavelength range that is greater than the visible 
wavelengths, and is often called electromagnetic radiation or optical radiation. 

In its most basic configuration, the instrument views and detects the form of radiant energy 
defined as radiance. With accessories, various set-ups, and built-in processing of the radiance 
signal, the instrument can measure:

 Spectral reflectance

 Spectral transmittance

 Spectral absorbance

 Spectral radiance

 Spectral irradiance
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E.2 Fiber Optic Collection of Reflected/
Transmitted Light

Optical energy is collected through a bundle of specially formulated optical fibers that are 
precisely cut, polished, and sealed for extremely efficient energy collection. The fibers 
themselves are of low hydroxyl molecule composition providing the maximum transmission 
available across the wavelength range of the instrument. 

E.3 Inside the Instrument
The fiber cable delivers the collected optical energy to the instrument, where it is projected onto 
a holographic diffraction grating. The grating separates and reflects the wavelength components 
for independent measurement by the detectors. 

E.4 Visible and Near-Infrared (VNIR)
The visible and near-infrared (VNIR: 350-1000 nm wavelength) portion of the spectrum is 
measured by a 512-channel silicon photodiode array overlaid with an order separation filter. 
Each channel (or detector) is geometrically positioned to receive light within a narrow (1.4 nm) 
range. The VNIR spectrometer has a spectral resolution (full-width half-maximum of a single 
emission line) of approximately 3 nm at around 700 nm.

Each detector converts incident photons into electrons. This photocurrent is continually 
converted to a voltage and is periodically digitized by a 16-bit analog-to-digital converter. This 
digitized spectral data is then transmitted to the instrument controller for further processing and 
analysis.

The 512-channel array can scan the entire VNIR spectrum in parallel at 1.4 nm wavelength 
intervals. A single sample can be acquired in as little as 8.5 ms.

E.5 Short-Wave Infrared (SWIR)
The near-infrared (NIR), also called short-wave infrared (SWIR), portion of the spectrum is 
acquired with two scanning spectrometers: 

 SWIR 1 for the wavelength range of 1001 nm to 1800 nm.

 SWIR 2 for the wavelength range of 1801 nm to 2500 nm.

The SWIR scanning spectrometer has one detector for SWIR 1 and another for SWIR 2. This is 
different from the VNIR spectrometer that has an array of 512 detectors. The SWIR spectrometer 
collects wavelength information sequentially rather than in parallel.
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Each SWIR spectrometer consists of a concave holographic grating and a single thermo-
electrically cooled indium gallium arsenide (InGaAs) detector. The gratings are mounted about a 
common shaft that oscillates back and forth through a 15° swing. As the grating moves, it 
exposes the SWIR 1 and SWIR 2 detectors to different wavelengths of optical energy. Each SWIR 
spectrometer has ~600 channels or ~2 nm sampling interval per SWIR channel. The 
spectrometer firmware automatically compensates for the overlap in wavelength intervals.

Like the VNIR detectors, the SWIR 1 and SWIR 2 detectors convert incident photons into 
electrons. This photocurrent is continually converted to a voltage and is periodically digitized by 
a 16-bit analog-to-digital converter. This digitized spectral data is then transmitted to the 
instrument controller for further processing and analysis.

The grating is physically oscillating with a period of 200 ms. It performs a forward scan and a 
backward scan, resulting in 100 ms per scan. This is the minimum time required for any SWIR 
samples or full-range samples.

E.6 Fore Optics
You typically collect reflected radiance and surface reflectance measurements using a hand-held 
configuration, though you can use a tripod. The pistol grip is available with both a sighting 
scope and leveling device when required for more precise orientation.

These accessories allow viewing the exact spot where the fore optic is pointed and orienting the 
fore optic in precise, nadir-viewing, geometry. The majority of irradiance measurements are 
performed with the irradiance receptor mounted level on a tripod because of the need for 
precise geometric orientation.

The small size of the instrument’s fore optics allows positioning the fore optics at a greater 
distance from the surface under observation.

A larger field of view means that fewer measurements are needed to approximate the spatial 
resolution of the imaging sensor, because the pixel size of most imaging sensor systems is 
several meters or more.

The small size of the pistol grip and fore optics greatly reduce errors associated with instrument 
self shadowing. Even when the area viewed by the fore optic is outside the direct shadow of the 
instrument, the instrument still blocks some of the illumination that would normally be striking 
the surface under observation, either diffuse skylight or light scattered off surrounding objects. 
Position the instrument as well as other objects — including the user — as far as possible from 
the surface under observation. This also applies to white reference measurements.

E.7 Dark Current Measurement
Dark current refers to current generated within a detector in the absence of any external 
photons. Dark current is the amount of electrical current that is inherent in the spectrometer 
detectors and other electrical components and is additive to the signal generated by the 
measured external optical radiation.

Noise is the uncertainty in a given measurement, one channel at a time. Noise, by definition, is 
random. You can reduce noise by using more samples and averaging the spectra or by increasing 
the sample count. Dark current is different from noise; it is relatively stable and can be 
characterized.
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This manual uses dark current to refer to all systematic contributions to the detector signal. Dark 
current is a property of the detector and the associated electronics (not the light source). Dark 
current varies with temperature. In the VNIR region, dark current also varies with integration 
time. 

Whenever you take dark current, the dark current calibration file is referenced. This signal is 
subtracted from each subsequent spectrum until another dark current is taken. The SWIR 
spectrometers take and subtract dark current on every scan.

You can update the dark current measurement at any time, but should update it more frequently 
in the beginning of a given session while the instrument warms up.

The VNIR spectrometer is fitted with a unique software and hardware combination called 
driftlock. Driftlock corrects for dark current changes over time. It automatically updates dark 
current for every measurement by looking at a series of masked pixels at the front portion of the 
VNIR array. The driftlock feature corrects for the majority of dark current variation over time.

E.8 White Reference
A material with approximately 100% reflectance across the entire spectrum is called a white 
reference panel or white reference standard.

The raw measurement made by the spectrometer is influenced by both the sample and the light 
source. An independent measure of the light source illumination on a reference of known 
reflectance is required to calculate the reflectance of the sample. The use of a white reference 
standard with near 100% reflectance simplifies this calculation.

Reflectance and transmittance are inherent properties of all materials and are independent of the 
light source. 

 Reflectance is the ratio of energy reflected from a sample to the energy incident on the 
sample. Spectral reflectance is the reflectance as a function of wavelength.

 Transmittance is the ratio of the radiant energy transmitted through a sample to the 
radiant energy incident on the surface of the sample. Spectral transmittance is the 
transmittance as a function of wavelength.

 Relative reflectance is computed by dividing the energy reflected from the sample by the 
energy reflected off a white reference panel or standard. 

Spectralon from LabSphere is a white reference standard that is very suitable for the VNIR and 
SWIR spectral ranges of ASD instruments.

Spectralon Reflectance Data
Figure E.1 shows reflectance data for an uncalibrated white Spectralon panel. When using a 
calibrated white Spectralon panel as the white reference for a reflectance measurement with the 
instrument, an even closer reflectance value for the sample can be calculated.
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Figure E.1: Typical 350–2500 nm spectral response of Labsphere 99% Spectralon

E.9 Gain and Offset
The gain value is the inverse of actual gain. A decrease in gain value will produce a higher gain. 
The maximum gain value is 16. Under the low light levels that create such a gain, small changes 
in offset will translate into large changes in dynamic range.

Offset causes a downward shift (from Y=32,768 DN) in a SWIR spectrum such that the 
maximum value of the spectrum and the minimum value of the spectrum (dark current - off 
screen) are equidistant from the line y=32,768. Under ideal conditions, where there is enough 
light, there will be about 32,768 DN of signal immediately after optimization, +/- 1,000. 

This means that optimization “creates” about 16,000 DN of dark current and about 16,000 DN 
of dynamic range. But this dynamic range will disappear with either a slight increase in signal (if 
the signal started out low to begin with) or a slight increase in dark current (increases with 
ambient temperature).
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Index
Symbols
.ini file needs updating 45

A
absolute reflectance, when to use 54
accessories

carrying in the field 29
light sources and probes 61
standard 60

accessory light sources
using to collect spectra 17

atmospheric conditions
effect on collecting spectra 64

B
backpack

adjusting straps to fit 25
attaching pistol grip clip to 26
protecting the instrument from bad weather 29
using 21

baseline
how often to collect 53

battery
charging 11
life 51
power status icon 12
specifications 47
status 12
using 11

battery charger
LED status indicator 11
specifications 47

belly board
setting up for first use 20
using 20

Bluetooth connection, setting up for GPS 33
broken fiber loss in fiber optic cable 13, 51

C
certifications 49
charging the battery 11
checking the fiber optic cable 14
cleaning

the fiber optic tip 36
the Spectralon reference panel 36

clouds
effect on collecting spectra 66

collecting
spectra in the field 62

collecting spectra
carrying the instrument for 19
options for 15
using accessory light sources 17
using fore optics 17
using the backpack 21
using the laptop carrier 20
using the pistol grip 16
using the remote trigger 17

communication
handling Windows firewall messages 44
instrument controller does not connect to the 

instrument 41
instrument controller does not connect 

wirelessly to the instrument 43
instrument loses wireless connection 43
setting up Ethernet 12
setting up wireless 12
troubleshooting common issues 38

computer requirements 9
configuring

a GPS device 32
the instrument controller for GPS 34
the RS3 software for GPS 34

conventions, typographic 1
converting data 58
customer service 2

D
dark current

measurement described 72
data

converting 58
more noise in data 57
noise bands 56
oscillations 55
post-processing 55
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sinusoidal wave, explained 55
steps in 57
VNIR drops to zero after dark current 58
VNIR spikes 56

default IP addresses
for the instrument controller 39

E
environmental specifications 48
Ethernet cable type 58

F
fan vents

maintaining 36
fiber optic cable

broken fiber loss 13, 51
by model 13
checking 14
handling 13
protecting the tip of 14
storing 14

fiber optic tip
cleaning 36

field measurement conditions, overview 62
field of view

determining 54
understanding 17

firmware needs updating 45
fore optics

and field of view 17
defined 72
using to collect spectra 17

G
gain, defined 74
GPS

configuring the device 32
configuring the instrument controller for 34
configuring the RS3 software for 34
installing GPSGate Client software 32
setting up 30
setting up a Bluetooth connection 33
setting up USB-to-serial converter 32
using 35

GPSGate Client software, setting up 32

H
hardware specifications 46

I
illumination

effect of artificial on collecting spectra 64
effect of natural on collecting spectra 63
effect on collecting spectra 63

instrument

back panel 3
carrying in the field 19, 21
front panel 2
models 2
overview 2
protecting from bad weather 29
sending it for maintenance or repair 37
serial number location 51
setting up 5
shipping 19
troubleshooting 38
unpacking 4
warm-up time 50

Instrument Configuration utility, using 45
instrument controller

carrying in the field 20
installing additional software on 59
requirements 9
setting up for first use in the field 20
software does unexpected things 59

IP addresses
default for the instrument controller 39

irradiance units 55

L
LAN

configuring the instrument controller for 39
default settings 12

language settings, Windows 10
laptop carrier

setting up for first use 20
using 20

loss from broken fiber in fiber optic cable 13, 51

M
maintenance

annual 37
sending the instrument for 37

materials
effect on collecting spectra 68

N
near infrared, defined 71
network

configuring the instrument controller for 39
default IP address for the instrument 

controller 39
specifications 49

NIR, defined 71
noise bands in data, explained 56
noise in data

explained 57

O
offset, defined 74
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optimizing, when to do 52
oscillations in data, explained 55

P
physical specifications 46
pistol grip

attaching clip to 26
using to collect spectra 16

post-processing data 55
power

options 10
specifications 47
using the battery 11

power status icon 12

R
radiance units 55
rain flap, using to protect the instrument 29
remote trigger

using to collect spectra 17
repair, sending the instrument for 37
requirements

instrument controller 9
software 10
ventilation 10

return merchandise authorization
requesting 37

RMA
requesting 37

rocks
effect on collecting spectra 68

S
sample count

what to use 53
serial number location 51
setting up

GPS 30
the instrument 5
the software 7, 8

shipping the instrument 19
short-wave infrared, defined 71
software

does unexpected things 59
installing on the instrument controller 59
saving spectra 7, 8
setting up 7, 8

software requirements 10
soils

effect on collecting spectra 68
specifications

battery 47
battery charger 47
environmental 48
hardware 46

network 49
physical 46
power 47
wavelength 48

spectra
collecting in the field 62
collecting options 15
collecting using accessory light sources 17
collecting using fore optics 17
collecting using the pistol grip 16
collecting using the remote trigger 17
saving 7, 8

Spectralon reference panel
cleaning 36
reflectance data 73

spectrograph
defined 50

spectrometer
defined 50
theory of operation 70
types 50

spectroradiometer
defined 50

spectrum average
what to use 53

steps in data, explained 57
support, technical 2
SWIR, defined 71
symbols used in this manual 1

T
technical support 2
troubleshooting 38

common communication issues 38
instrument controller does not connect to the 

instrument 41
instrument controller does not connect 

wirelessly to the instrument 43
instrument loses wireless connection 43
Windows firewall messages 44

typographic conventions 1

U
unpacking the instrument 4
USB-to-serial converter, setting up for GPS 32
user account control settings, changing 39

V
vegetation

effect on collecting spectra 67
ventilation requirements 10
visible and near-infrared, defined 71
VNIR drops to zero after dark current

explained 58
VNIR spikes
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explained 56
VNIR, defined 71

W
warm-up time 50
wavelength specification 48
WEEE compliance 49
white reference

collecting larger than Spectralon panel 54
defined 69, 73
how often to collect 53
reflectance data 73

wind
effect on collecting spectra 67

Windows firewall, handling messages from 44
Windows language settings 10
wireless connection

default settings 12
instrument controller does not connect to the 

instrument 43
instrument loses 43
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